QXS Licensing Guide

Figure 1 provides an illustration of the QXS systems that support the applicable
QXS licenses:

* 12-drive system (2U high)
* 24-drive system (2U high)
* 48-drive system (2U high)
* 56-drive system (4U high)

Figure 1 QXS Systems

1 12-drive system (2U high) 2 24-drive system (2U high)

3 48-drive system (2U high) 4 56-drive system (4U high)
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Supported and Unsupported Systems

This section covers the following information:

e Supported Systems

e Unsupported Systems

Supported Systems The information and instructions in this document are for Quantum-branded
systems only, and do not apply to the Dot Hill/Seagate-branded systems and
other QXS systems. See Unsupported Systems for more information.

Note: Q-Tier License:
- The QXS-3 Series systems do not support the Q-Tier license.
- The QXS-4 and QXS-6 Series systems do support the Q-Tier license.

* QXS-3 Series
* QXS-312 (12-drive chassis)
* QXS-324 (24-drive chassis)
* QXS-4 Series
* QXS-412 (12-drive chassis)
* QXS-424 (24-drive chassis)
* (QXS-448 (48-drive chassis)
* QXS-456 (56-drive chassis)
* QXS-6 Series
* QXS-648 (48-drive chassis)
* QXS-656 (56-drive chassis)
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Systems not supported by this document are:
* Dot Hill/Seagate-branded
* The serial number is the key.
* If the serial number starts with “DHS”, system is not supported.
* QXS-1200
* QXS-2400
* QXS-5600
* QX-1200 and QX2400

* Xcellis embedded metadata arrays

Note: If you add primary QXS storage to an Xcellis system, this document
applies to that primary QXS storage.

e Artico

* Pro Foundation

Note: QXS licenses are preloaded on Excellis, Artico, and Pro Foundation.
The QXS system is considered embedded storage within these
systems.

* Other appliance hardware that uses “embedded” QXS

QXS Standard and Optional Licenses

This section covers the following information:

* QXS Online Help License Names

e QXS Licenses and Features

QXS Online Help
License Names

Note: The Disk Management System (V3 GUI) provides online help that uses
Seagate-centric license names.

Quantum license names differ from those presented in the License Settings
panel. Figure 2 provides the Quantum license names and compares them to the
Seagate-centric names in the License Settings panel.
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Figure 2 Seagate-Quantum
License Name Comparison

License S

ettings

-

Quantum License Name

Q-Snap
Q-Tools

Q-Tier
Q-Copy

QXS Licenses and
Features

Table 1 lists the QXS licenses and some of their features that are available
through Quantum.

Note: Table 1 also shows the applicable Seagate name that you might need as
a reference. The Seagate names appear in the QXS GUI.

See QXS License Descriptions on page 6 for detailed information on all

licenses.
Table 1 QXS Licenses
Quantum Standard or
Name Seagate Name Features Optional Feature
Q-Tools RealStor, ¢ SSD Read Cache Standard

Virtualization * Creation of virtual pools.

¢ Quick rebuild.

* Thin provisioning—allocate physical
space just-in-time.
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Quantum Standard or
Name Seagate Name Features Optional Feature
Q-Tier RealTier Ensures that the most frequently used data is | Optional
AssuredTier in the highest-performing storage. Constant | Note 1: Not
Performance tier lk?ack?round scanning for “hot” data with supported on the
} hot” data moved immediately—no waiting. | Qxs-3 Series
SSD Tier ]
¢ Real-time SyStemS.
. . Note 2: Q-Tier is pre-
Intelligent installed on the
* Automated Xcellis SSD system
* Tier data based on usage from HDD to (Sesrgs?:g;ﬂe?j;(s has
HDD (for example, 7K to 10K/15K) and '
HDD to SSD.
* Frequently accessed, “hot” data can
move to drives with higher performance,
lower capacity, and higher costs.
* Infrequently accessed, “cool” data can
move to drives with higher capacity,
lower performance, and lower costs.
Q-Replicate RealSpan * Schedule when replications will occur. Optional
RealRemote * Uses snapshots.
AssuredRemote . .
o * Optimal for long distances.
Replication o . _
* Minimizes time and bandwidth vs
synchronous replication.
Q-Snap 3xx RealSnap Distinct snapshot licenses are provided for Optional
Q-Snap 4xx AssuredSnap QXS-3, Q_XS-4aafnd ?\XS'6 Series Systerkr:s. ; Note: The correct
Q-Snap 6xx Licensed Keys ar:e |ssfue o;t e maximum Ir|1um ero license must be
snapshots snapshots for each system/controller type. !ourchased and
* QXS-3: 512 snapshots installed, based on
the controller type
* QXS-4: 1024 snapshots (QXS-3, -4, and/or -6
¢ QXS-6: 1024 snapshots Series arrays).
Q-Copy RealCopy * Makes a copy of data to another set of Optional
AssuredCopy disks within the array
Volume Copy * Controller based

* No host resources used
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QXS License Descriptions

This section provides a detailed description of the QXS licenses. The information
includes:

* Q-Tools

* Q-Tier

* Q-Replicate
* Q-Snap

* Q-Co

The Q-Tools license is a standard option on all QXS systems (pre-installed).

Figure 3 Q-Tools Standard
Option
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Q-Tools

Figure 4 Cache — SSD Read
Cache
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Q-Tools includes the following options:
* Cache — SSD Read Cache

¢ Thin Provisioning

e Automatic Pooling
e Quick — RAID Rapid Rebuilds

Cache — SSD Read Cache

Cache supports SSD/HDD configurations that dramatically increase the amount
of read-cache available to the storage system.

Using one or two SSDs in the storage configuration automatically activates the
read-cache function, which can improve the overall performance of read-
intensive applications and workloads.
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Thin Provisioning

Thin provisioning streamlines the tasks of provisioning and modifying volumes,
allowing IT managers to respond to data growth as needed.

Figure 5 Thin Provisioning

— o o o o

— il

o — -

Disk space is only used when written to, and LUN size is independent of the
physical disk space used. IT managers can add storage when needed, easily
expanding volumes non-disruptively.

Automatic Pooling

With Storage Pooling, the disks—whether physical or logical—can be
aggregated into pools from which the logical volumes are allocated. This greatly
simplifies storage allocation by eliminating the need to manage partitioned
space on the physical storage resources.

Figure 6 Automatic Pooling
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Quick — RAID Rapid Rebuilds

Within each collection of disk drives that make up a storage pool, data is further
protected with RAID redundancy within each tier. In a typical RAID system,
rebuilding a drive can be time consuming, especially with high capacity drives,
because each sector requires rebuilding.

Quick speeds up RAID rebuilds, because only the sectors that contain actual data
are rebuilt, resulting in up to 5 times faster restoration of the RAID set. For
instance, a drive that is only 50 percent utilized will rebuild in 50 percent less
time with Quick.

QXS Q-Tier provides intelligent, automated, real-time storage tiering, by moving
the most frequently used data onto the highest-performing storage tier for
optimal performance.

Keeping in-demand data in the highest-performing storage is the smart thing to
do. QXS hybrid storage incorporates intelligent data access algorithms to ensure
that the most requested data is placed in the highest-performing tier, seamlessly
and automatically. This enables the optimal use of higher-cost, high-
performance storage.

Note: Q-Tier License:
- The QXS-3 Series systems do not support the Q-Tier license.
- The QXS-4 and QXS-6 Series systems do support the Q-Tier license.
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Figure 8 Data Tiering

> NEED

Existing Tiering Software vs Q-Tier

Existing tiering software often works in a batch mode, moving large amounts of
data every 24 hours or is policy-based and requires significant manual
intervention. Organizations today operate 24x7, with no down time. Moving
large data sets in a batch process slows down applications, slowing down
business.

Q-Tier considers the dynamic nature of the data being accessed and
automatically and continuously moves the data to the appropriate tier to
immediately and consistently improve application and business performance.

Quantum's QXS Q-Tier

QXS Q-Tier is intelligent, automated, real-time storage tiering that ensures that
the most frequently used data is in the highest-performing storage when it is
needed. QXS Q-Tier uses an intelligent algorithm that continuously scores, scans
and sorts the data. This scoring, scanning, and sorting process occurs every 5
seconds, continuously moving data between tiers as the data being accessed
changes.

10
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Function Description

Evaluates the data based on how frequently
and how recently it is accessed.

Scoring

Constant background scanning identifies
high-score data. A scan occurs every 5
seconds, using less than 1% of system CPU.

Immediately moves data to the appropriate
tier.

Sorting

Optimizing Storage Investment

Tiering data requires both computing power and storage bandwidth. Unlike
other hybrid storage arrays that tier data daily to avoid performance
degradation during peak hours, QXS arrays have dedicated processing and dual
active-active controllers to tier data every 5 seconds, constantly promoting
active workloads to the fastest tier available, with no reduction in performance.

QXS License Descriptions
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Figure 9 Storage

QXS Q-Tier: Migrates Data Every 5 Seconds

This provides the most needed data with the highest I/O possible, and also
reduces bottlenecks.

Figure 9 provides an example of data movement between capacity HDDs,
performance HDDs, and SSD.

Continuous Data Movement @ lI _ SSD
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Q-Replicate

 CAPACITY HDD

[ Hot Data [ Warm Data Ml Cold Data

Q-Replicate software enables IT professionals at small to medium-sized
businesses to solve many of today's critical data protection challenges by
building complete solutions for business continuance, disaster recovery, and
regulatory compliance. Q-Replicate works between two SAN arrays to replicate
data between sites, protecting valuable data assets.

Q-Replicate provides the ability to quickly protect your storage environment.
Using the existing point-in-time snapshot technology, Q-Replicate only captures
changed data, limiting the amount of data copied across to the remote site.

Unlike other replication technologies, the Q-Replicate implementation is both
easy and fast, and also reduces the size of snapshots by storing only a single

instance of changed blocks. This minimizes the amount of data to be copied

across data lines.

12
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Features include:

* Use over Ethernet or Fibre Channel.
» Ethernet ports can be used for both local and replication traffic.
* Replication snapshots can be used for both local and remote recovery.

* Remote site can be ‘stood up’ for a period then ‘failed back’ to the primary
site to resume normal operations.

* Bi-directional replication allows an array to act as both a primary and a
remote site.

Q-Snap provides the ability to create point-in-time copies or backups of disk
volumes, with instant restoration of data to any captured (snapshot) point in
time. Since Q-Snap only copies data that has changed, it can virtually eliminate
backup windows.

Q-Snap uses a method called “Single Copy-on-Write (SCW)"” and includes
Original/Write Data Preservation technology. Unlike other snapshot
technologies, Q-Snap is not only fast, but it also reduces the size of snapshots
by storing only a single instance of changed blocks.

Original/Write Data Preservation technology is unique in the market, allowing IT
managers to snapshot and write to newly created snapshot volumes. This
enables rollbacks to the original snapshot or to the modified or updated
snapshot. This is ideal for testing new software or prototyping new applications.

Q-Copy provides the ability to create full volume copies or backups of disk
volumes and quickly restore whole volumes, folders, or individual files. Q-Copy
creates a full volume copy, which protects against disk failures, accidents, or
attacks.

With Q-Copy, whole volumes, folders, or individual files can be quickly restored
from the volume copy. Q-Copy provides additional protection against complete
volume or RAID group loss. If a double disk fault occurs in a RAID 5 set, the
source data remains protected; this would not be the case with snapshots.

QXS License Descriptions
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Volume copies can be mounted to other application hosts to provide production
data support for backup, rapid development and test, data mining, decision
support, and other applications, without putting production data at risk or
impacting application performance, because access is to an independent data
set.

The QXS ‘set and forget’ scheduler capability gives storage administrators peace
of mind, knowing that the storage system is automatically making snapshots
and volume copies.

Acquiring QXS Licenses

Quantum-branded QXS-3/4/6 systems receive Q-Tools license by default.
* No certificate is required. The license is pre-installed.

* The user interface will show licenses pre-installed for a given serial number.

Note: Users who order add-on licenses receive a certificate with an
authorization code for the licenses.

See Installing QXS Licenses on page 22 to verify what licenses have
been pre-installed on your QXS system.

Optional QXS licenses that can be purchased include:
* Q-Tier

Note: Q-Tier License:
- The QXS-3 Series systems do not support the Q-Tier license.
- The QXS-4 and QXS-6 Series systems do support the Q-Tier license.

* Q-Replicate

* Q-Snap 3xx, Q-Snap 4xx, and Q-Snap 6xx

* Q-Copy
Acquiring License You can order licenses from Quantum through the standard PO process.
Certificates Quantum will send paperwork for the order

Note: This order process is only for the supported models. See Supported
Systems on page 2 for a list of supported models.

Orders for systems listed in Unsupported Systems on page 3 do not
follow the standard PO process.

If you have questions about the ordering process, see Contacting Quantum on
page 28.
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See Figure 11 for an example of the certificate (with authorization code) that

the you will receive with your order.

Figure 11 Certificate with
Authorization Code

Quantum.

LICENSE KEY CERTIFICATE FOR: QXS
AUTHORIZATION CODE:

Please follow the instructions on this certificate to activate your licensed feature. The Authorization
Code contained herein is an exclusive, one-time use code that enables you fo obtain the
appropriate License Key. Retain this certificate as your proof of purchase.

Instructions
1. Retrieve and record the unit serial number. For easy record keeping, write the serial
numier in this location:
Acoess the License Key Management website and follow the instructions by providing the
Seral Mumber and Authorization Code fo obtain your new License Key file.
The License Key Management website address is: hitp:/femew. quantum.comlicenseheys
Sawve the licensa key file to a convenient location on your local systam.
Depending on the version of Disk Management | tility, follow steps 5 or .
Disk Management Ltility ('3 GLI:
a.  In Home topic, select Action = Install License.
k. On the Permanent License tab, cick Choose File to locate and select the licsnse
file.
c. Click OK
Disk Management Utility (W2 GUI
a Inthe Configuration View panel, right-click on the system and select
Tools = Install License.
k. Click Choose File to locate and select the license file.
c.  Click Install License File.

Helpful Information

If you experience any difficulty with the website or use of this authorzation code, please call
Cluartum technical support at the country appropriate number listed on the Quantum website:
it/ quantum. com'supporticontact

Mote: Use of your Authonzation Code will generate a unique License Key file which you can
download. The Authorzation Code and License Key file are provided for the exclusive use of
Purchaser, may b= used ane Sme only, and are non-fransferable.

Purchaser is responsible for maintaining the confidentiality of the Authorization Code and License
Key file, and is fully responsible and liable for activities which occur as a result of the use of either.
Purchaser must provide immediate notification to Supplier of any unauthorized use of which you
become aware.

Do Mumber: 3-07635-01, Rev A, February 2016

Acquiring QXS Licenses
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Finding System Serial You can find the system serial number on the top of the RAID chassis, or in the
Number disk management utility (GUI).

System Serial Number on RAID Chassis

1 Retrieve the serial number from the top of the RAID chassis.
a The serial number is located at the top right of the chassis.

b Refer to Figure 12 for serial number location.

Figure 12 Serial Number
Location on RAID Chassis

¢ A Quantum serial number example is (Figure 13):
QTMCHOU-12345AB678

Note: A valid serial number is required for the license acquisition to work
properly. If an incorrect serial number is entered, you cannot
acquire the applicable license.

Figure 13 Serial Number
Location on RAID Chassis

M0 MR ERT MM Assembled in - AU

P/N: 8-01532-01 United States REV:A
Service Call Sﬁ/stem Serial Number

System S/N: QTMCHOU-12345AB678

2 Record the RAID chassis serial number.

For easy record keeping, write the serial number in this location:
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System Serial Number Using Disk Management Utility (GUI)

1 Access the disk management utility (V3 GUI).
2 Select System on the left side of the screen.

3 Select either the Front or Rear tab.

Note: The system serial number will be that of the RAID chassis, which is the
top chassis on the System page.

4 Hover the cursor over one of the “ears” (far left or right) to display the
Enclosure Information popup.

a The serial number you need is the Midplane Serial number.

b Refer to Figure 14 for an example of the screen and Enclosure
Information (RAID Chassis) popup (serial number).

Figure 14 System Serial
Number in the GUI

I  Action SYSTEM

J. Front | Rear  Table

@

ggg
ezt Enclosure Information
= D °
== Status: Up
Pools Vendor: DrotHill
Model: HD Root
g Disk Count: 55
i WWN: S00COFFOMEGASAIC
A ] Midplane Serial: QTMCHOU-14491E8A54
Revizion: A
—

=
o
=
2,
B
@

]

Performance
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Figure 15 Serial Number on
Popup Screen

QXS License Process

c Refer to Figure 15 for a closeup of the Enclosure Information (RAID
Chassis) popup (serial number) screen.

" Enclosure Information |
ID: 0
Status: Up
endor DrotHill
Model HD» Root
Disk Count: 33
WWN: S00COFFO1ESASAIC
Midplane Serial: OTMCHOU-14451E5A5A
Revision: A
& 0K

Complete the following steps to review current licenses or to acquire QXS
licenses:

Note: If you want to check the current licenses on a system, complete
Step 1 to Step 4.

1 Access the License Key Management website at (Figure 16 on page 19):
http://www.quantum.com/licensekeys

2 Enter the RAID chassis Serial Number on the License Key Management
website page.

3 Click on the “Submit” button.

Note: You will receive a license file. You must apply the license file through
the QXS GUI (V3).

18
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Figure 16 License Key
Management Website

Quantum

Products - Solutions - Industries ~ Applications - Support - Success Stories

SUPPORT

License Key Management

CONTACTUS

Live Chat with a Quantum
Upgrade Licenses Serial Number: Sales Consultant g ‘

CLICK HERE P
Search for your upgradeable Quantum product by

entering the Serial Number.

[:- Request More Information
Request Information La

))} Contact Quantum Sales
(B00) 677-6288 (US / CAN) [

))) Contact Quantum Support
(800) 284-5101 (US / CAN) [

4 \Verify that the second License Key Management website page appears
(Figure 17 on page 20).

a Any licenses applied to the serial number are shown.
b Any factory installed licensing is also shown.

c Names on this page are subject to change to align with Q-xxx names.
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Figure 17 Second License Key
Management Page

QXS - License Key Management

]

Current Configuration

REPLICATION ONM
3DD TIER OFF
SHNAP SHOTS OFF
SRA ON
VDS ON
VIRTUALIZATION OFF
VOLUME COPY OFF
W55 ON

QX5 version Version 1.0

Serial Number: TSTQX3436R512012

Choose Another
8ZT7-QDBB-CNJV-HF3D | | Get License Key |
Activated Feature Authorization Code Date
W55 factory installed 02-25-2016 details
VD5 factory installed 02-25-2016 details
SRA factory installed 02-25-2016 details
REPLICATION 8T 7-QDBB-CNI-HF3D 02-25-2016 details

5 Enter the “Authorization Code” into the field by the “Get License Key”
button (Figure 17).

Note: The Authorization Code is a one-time use only.

6 Click on the “Get License Key" button.

7 When the authorization is entered, and if the authorization code is
accepted, verify that a third License Key Management page appears

(Figure 18 on page 21).

20
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Figure 18 Generate License
Key File

QXS - License Key Management

QX5

Your new license key has been retrieved
successiully. Please enter this license key
into your QX5 to activate the feature.

[ Generate License Key File ]

| Continue
License Key Details
Serial Mumber: TSTOXS456RS12012
Authorization Code 8ZTT-QDBB-CNMNV-HF3D
Date: 21252016
License Key: License Key File
Feature: REPLICATION

8 Click on the Generate License Key File.

Note: You will receive a license key file. You must apply the license key file
through the QXS GUI (V3).

9 Save the license key file to a convenient location on your local system.

a The generated file contains only the single key associated with the
authorization code.

b Keys are only useful for a single serial number.
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Installing QXS Licenses

Use the Disk Management Utility (V3 GUI) to install the applicable QXS license.

The License Settings GUI page identifies installed licenses and lets you specify a
license file to apply a new license (Figure 19 on page 22). Information on the
page includes:

* Snapshot license are represented by a count (example: 512)

* License names on GUI remain Seagate-centric at Gx222 firmware

Figure 19 GUI License Settings
View

NUA,
A,
MUA,
NJA,
MNumber

that are nol permanently kensed

Click OK below to register icense

Installing a License Complete the following steps to install the QXS license with the V3 GUI:

Using V3 GUI 1 Log in to the disk management utility, V3 GUI (Figure 20 on page 23).
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Figure 20 Logging into V3 GUI

¢ Q search * B 4+ A& @

(- (i) | perfqxsS6a.mdh.quantum.com/v3/index.htm

Quantum.

Quantum StorNext Disk Storage
Management Utility

User name;

Password:

2 In Home topic, select Action > Install License (Figure 21).

Figure 21 Selecting Install
License

C || Q Search *®B8 +§ A © QO =

(- (i) | perfqxsS6a.mdh.quantum.com/v3/index.htm

Quantum

M

HOME

Configuration Wizard

Provision Storage Hosts —
Set System Information

[ v o

[Oe] Manage Users i.i I

] Set Up Notifications 0 Host Groups. 0 Hosts 4 Initiators (4 ungrouped)

System chedules

L Ports A Ports B

—]
gsg = . - 010PS e - =
e H e | H W owes | Wi ‘ we || W
N AD-FC Al1-FC A2-FC A3-FC BO-FC B1-FC B2-FC
== Capacity
Logical: Allocated: 287TB
Physical: - Disk Groups: 330TB L
=]
E
— Storage A ! Storage B
Vol s
e Virtual: No Virtual Pool

Virtual: No Virtual Pool
Linear: 2 Volumes, 0 Snapshots

Linear: 2 Volumes, 0 Snapshots
Allocated: 143TB o | Allocated: 143TB
0| -

Niek Rraun | Hilatinn Nisk Rrnon |
i ] »

€ 09-41:22: Finished loading configuration data.
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3 Click the Permanent License tab, and then click Browse to locate and select
the license file (Figure 22).

Figure 22 Choosing License

File
T % .- o= —— — — = r\"
5 Google Rf 10.65.167.230 [A] (perfgxs5... x + "y .
e Q Search * E

&= ® perfgxsd6a.mdh.quantum.com/v3/index.html

Quantum

Action...

License Settings

Feature

Virtual: No Virtua
Linear: 2 Volume

Disk Group Utilizatior

(=

Mapping

3

Performance

Tier

10PS

4 Click OK.

Note: The license becomes available after installation. A reboot of the
RAID chassis is not required.
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Installing License Using Complete the following steps to load the QXS license with the V2 GUI:

V2 GUI 1 Log in to the disk management utility, V2 GUI (Figure 23).

Figure 23 Logging into V2 GUI

e - W W il i i (S

10.65.167.230 [A] (perfgxs5... * | +

\ €& | () | perfgxss6a.mdh.quantum.com/v2/index.htm ¢ || Q Search *la $ A © :

Quantum. StorNext.

Quantum StorNext Disk
Storage Management
Utility

Click to launch newer version of this application.

User name: | |
Password: | |
Language: user setting -
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2 In the Configuration View panel, right-click on the system and select Tools
> Install License (Figure 24).

Figure 24 Configuration View
Panel

o - . (=]
- 10.65.167.230 [A] (perfqxss... x\ g -
':_,\(-'J' @® perfgxs36a.mdh.quantum.com,/v2/index.html c | Q Search | ﬁ E ‘- ‘ﬁ‘ =] a
” o . User: manage
Quantum StorNext Disk Storage Management Utility [ el
—— perfgxs56 (StorNext QXS)
System Time  2016-08-24 09:37:57
: View v Provisioning » Configuration v Tools v Wizards v Help
e Bt 2 @ T
Configuration View 2 Install License
System Overview Save Logs
(== ] Select an entry from the table t e the details Reset Host Port

iﬁ-f-perfqmss(smrMQXSJ

#. Logical

Vdisks

Hosts
& Physical
L = Enclosure 0

‘ snfs_data L2 (RAID6E)
a snfs_data_L3 (RAIDE)
‘ snfs_data_L4 (RAIDE)
j snfs_data_L5 (RAIDE)

Rescan Disk Channels
Clear Disk Metadata

Health Component +..| Shut Down or Restart Controller
n Test Event Notifications and Managed Logs
Degraded System —

@ a Check Local System Link
© @ ok Enclosures 1 Reset or Save Disk Performance Statistics i
© @ Disks 55 30178 e
(@) & Degraded  Vdisks 4 287 8T ==
© Virtual Storage 0.0MB
O @ Volumes 4 267618 —
® Schedules 0
O Configuration Limits
@ Versions
© Snap Pools 0 0.0MB
® Snapshots 0
O Licensed Features

n Information
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3 Click Browse to locate and select the license file (Figure 25).

Figure 25 Choosing License
File

10.65.167.230 [A] (perfaxs5... *

N - F !lgl@!
H __

'(-' () | perfgxs56a.mdh.quantum.com/v2/index.html ¢ || Q Search ﬁ B ¥+ & © O :

Quantum StorNext Disk Storage Management Utility

System Status perfgxs56 (StorNext QXS)

System Time  2016-08-24 08:56:20

View » Provisioning v Configuration » Tools v Wizards v Help

SystemEvents E4 0 ¥ 0 : 0 €) 1

Configuration View

perfqxss6 (StorNext QXS) > Tools > Install License

Install License
= Install a temporary or permanent license

ib‘?.pe.rqusﬁ{anrMQXSj

#. Logical

Vdisks Feature Max Licensable | Expir
‘ snfs_data L2 (RAID6E) Licensed Snapshots 0 512
Virtualization NIA Enabled MNIA NIA Mever
fs_data L3 (RAIDG
@ snfs_data_L3( ) Performance Tier  NiA Enabled NIA NiA Never
A @) snfs_data_L4 (RAIDE) Volume Copy N/A Enabled N/A N/A Never
6 snfs_data_L5 (RAIDG) Replication NA Enabled MNIA N/A MNever
- VDS NIA Enabled MNIA NIA Never
Hosts
b VSS N/A Enabled N/A N/A Never
i PySiea SRA A Disabled NIA A Never
L Enclosure 0

You may install a permanent license.

Licensing Serial Number: 1EGASA
Licensing Version Number: GL210

Select a license file for upload:

| Browse... | Mo fie selected. | (__Install License File ]

4 Click Install License File.

Note: The license becomes available after installation. A reboot of the
RAID chassis is not required.
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Contacting Quantum

More information about this product is available on the Quantum Service and
Support website at http://www.quantum.com/ServiceandSupport/Index.aspx.
The Service and Support Website contains a collection of information, including
answers to frequently asked questions (FAQs). You can also access software,
firmware, and drivers through this site.

For further assistance, or if you are interested in training, contact the Quantum
Customer Support Center:

United States 1-800-284-5101 (toll free)
+1-720-249-5700

EMEA +800-7826-8888 (toll free)
+49-6131-324-185

APAC +800-7826-8887 (toll free)
+603-7953-3010

For worldwide support:
http:/www.quantum.com/ServiceandSupport/Index.aspx
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